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Module Title: LEARNING TECHNOLOGIES 
Authors:  KATHY LYNCH AND GREG LANCASTER 
 
Module Description: 
 

This module will introduce participants to a variety of low cost 
computer peripherals for sound and image recording.  Participants will 
develop skills in using scanners, digital cameras, video and associated 
software to produce simple multimedia elements.  The participants will 
then practice combining these elements to produce a basic multimedia 
science related resource for students and teachers. 
The module presents a variety of activities for the facilitator from 
which to select the most appropriate activities.  It is not intended that 
the participants attempt all activities.  The facilitator is advised to 
survey the participants to choose the activities that will provide new 
experiences and sufficient challenge for her/his audience. 

 
Summary of Activities:  Title Min 

 0 Prior survey of participants’ existing skills Att.0 

 1.0 Creating digital audio from a tape or CD player. 15 

 2.0 Creating digital audio.    5 

 3.0 Using a scanner. 10 

 4.0 Image enhancement and special effects. 15 

 5.0 Using a digital camera to capture still images 20 

 6.0 Using a digital video camera. 20 

 7.0 How to use digital elements in the science classroom. 20 

 8.0 Integrating audio and images into a science 
presentation. 

25 

 9.0 Creating a simple science multimedia resource. 20 

 
Module Outcomes: • Increase awareness of digital imaging technology and its 

application as a learning tool in science education. 
• Develop skills in the capture of science related sound and digital 

images using a range of peripheral devices. 
• Provide practice at integrating images and sound into other widely 

used educational software packages. 
• Provide practice at combining simple sound and image components 

to produce a basic multimedia science resource for students or 
teachers. 

 
 
Pre-module  
Skills Survey: 

• This is available as Attachment 0, and also exists as a file in the 
Administration folder. 

• Completion by participants at least a week before the Learning 
Technology module, will allow appropriate planning. 
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Resources and 
Materials: 

• DEET “Acer” laptops or desktop computers 
• Cassette tape player or CD Player. 
• Connectix “QuickCam VC” or Tops-Mate Int’l Corp. “CUCUS” 

(or similar) for still image and video capture. 
• Kodak “DC50”or Sony “Mavica” (or similar) digital camera for 

high resolution still images. 
• Image scanner 
• Samples of black and white drawings, colour drawings and 

photographs. (Magazines, text books etc) 
• External microphones (DEET Laptops, “Acer Extensa 500T” have 

a microphone integrated into the top left of the screen.) 
• Optional - data projector, Web access 
• Attachments as below can be found on the CD under 

LrnTech/Attachments/; 
1.0 Digitising audio from a cassette tape 
2.0 Creating digital audio 
3.0 Using a scanner 
3.1 Respecting Copyright  
3.2 Image file formats –Which one to use? 
4.0 Manipulating digital images 
4.1 Digital stills to digital video 
4.2 Image Enhancements and special effects 
5.0 Capturing still images with a digital camera 
5.1 Setting up a Logitech/Connectix “QuickCam – VC” 
5.2 Setting up a Kodak DC50 
6.0 Using a digital video camera 
7.0 Ideas for digital elements in Science 
8.0 Creating a multimedia resource using MS PowerPoint 97 

• DEET on-line discussion area - http;//www.sofweb.vic.edu.au 
• Other related professional development programs, such as 

Computers Across the Secondary Curriculum, Computers Across 
the Primary Curriculum, Learning with the Internet. 

• Sony “Mavica” digital imaging camera 
Http://www.sel.sony.com/SEL/consumer/ss5/pin.shtml 
• Connectix QuickCam Cameras 
Http://www.logitech.com/au/cameras/index.html 
• Kodak Digital Learning Centre  
Http://www.kodak.com/US/en/digital/dlc/ 
• Commercial image/photo/clipart CD collections - Kodak digital 

science Photo CD Sampler, Corel Web Graphics CD, SciArt CD - 
Cambridge University Press or http://www.eduart.com.au 

• Collins, Hammond and Wellington (1997) "Teaching and learning 
with multimedia" Routledge London 

• Grabe, M and Grabe C (1998), "Integrating technology for 
meaningful learning" Houghton Mifflin Company, Boston 

• Rodrigues, S & Corrigan, D (1998) "Including IT: Managing 
information technology in the science classroom" User Friendly 
Resources Enterprises Ltd.  Book #190 

http://www.sel.sony.com/SEL/consumer/ss5/pin.shtml
http://www.logitech.com/au/cameras/index.html
http://www.kodak.com/US/en/digital/dlc/
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Activity 1.0 : Creating Digital Audio from a Tape or CD Player 

 
Purpose: 

 
To create a digital audio file from a cassette tape or CD player.   

 
Resources required: • Cassette tape player or CD player with recorded sound. 

• Computer with ‘line-in’ socket (to go into the sound card). 
• Audio cables with correct plugs to connect sound player and 

computer. 
• Attachment (1.0) “Digitising audio from a cassette tape”. 

 
Teaching Procedures: Activity based investigation using Attachment (1.0) 

 
Time allocation: 15 minutes 

 
What to do FACILITATOR PARTICIPANT 

1.1 Organise participants into 
groups of at least two, and 
have floppy disks or hard disk 
space allocated for each 
group. 

 
1.2 Refer to Attachment (1.0) 

"Digitalising audio from a 
cassette tape”.  

 
1.3 Copy and use hand out as 

required. 
 
 
 
 
 
 
 
1.4 Using a whiteboard, start the 

development of a definition or 
question and answer board.  
This can be used to assist 
participants in building up a 
glossary of definitions and 
technical terms. 

 

1.1 Form into working groups 
with equipment. 

 
 
1.2 Read Attachment (1.0) and 

digitalise a sample of sound 
from a cassette tape. 

 
1.3 Save file onto a floppy disk or 

a dedicated place on the 
computer's hard disk and 
replay. 

 
Explore as time permits the 
various sound options, such as 
reversing the sound, adding 
echo and practice saving and 
editing files. 

 
1.4 Obtain a copy of the definition 

or question and answer board.  
Continue to use this 
throughout the module. 
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  Discuss/Consider: 
• File size and storage medium. 
 
• Where to obtain sounds eg animals, people talking, etc. 
 
• Sound wave analysis – e.g. Displays the frequency, wavelength and 

harmonics of the recorded sound. 
 
 

Tips and Tricks: • Determine the format requirement of the end application before 
digitising the sound.  

 
• The recording settings on the computer may need to be adjusted 

before you start (in Windows95, right-mouse click on the sound 
icon>Open Volume Controls>Options>Recording). 

 
• The Windows Sound Recorder is adequate, however the sound 

recording software that comes with many sound cards (eg Vibra) 
are usually better (more options, cut segments, sine wave display). 

 
• It is less time consuming to create the digital sound directly as in 

Activity 2.0 
 
 

Skills Checklist:  Connecting a cassette player or CD player to a computer. 
 
 Saving and retrieving computer files. 
 
 Creating a digitised sound file from a pre-existing non-digital 

sound. 
 
 Using a sound editing application. 
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Activity 2.0 : Creating Digital Audio  

 
Purpose: 

 
To create a digital audio file using a computer and microphone. 

 
Resources required: • Computer with microphone jack or integrated microphone. 

• Compatible microphone. 
• Attachment (2.0) “Creating digital audio”. 

 
Teaching Procedures: Activity based investigation using Attachment (2.0).   

 
Time allocation: 5 minutes 

 
What to do FACILITATOR PARTICIPANT 

2.1 Organise participants into 
similar groups as in Activity 
1.0 

 
2.2 Refer to Attachment (2.0) 

“Creating digital audio”. 
Copy and use handout as 
required.  

 
 
 
 
2.3 Using the board, continue 

with the development of a 
definition or question and 
answer diary. 

 
 
 

2.1 Form into working groups and 
allocate equipment to groups 
as required. 

 
2.2 Read Attachment (2.0) and 

digitise a sample of sound 
using a microphone. 

 
2.3 Save file on a floppy or a 

dedicated place on the 
computer’s hard disk. 

 
2.4 Add unfamiliar terms or 

questions and answers 
obtained during this activity to 
the definition or question and 
answer diary.  Continue to use 
this diary throughout the 
module. 

 
 Discuss/Consider: 
• File size and storage medium. 
 
• Sending sound files as attachments to e-mail. 
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Tips and Tricks: • Determine the format requirement of the end application before 
digitising the sound. 

 
• The recording settings on the computer may need to be adjusted 

before you start (in Windows95, right-mouse click on the sound 
icon>Open Volume Controls>Options>Recording). 

 
• Again the Windows Sound Recorder is adequate, however the 

sound recording software that comes with many sound cards (eg 
Vibra) are usually better (more options, cut segments, sine wave 
display). 

 
• Audio files can quickly become very large, so keep your recordings 

short and content straight to the point.  Write a script and rehearse. 
 

 
Skills Checklist:  Connecting a microphone to a computer. 

 
 Creating a digitised sound file directly into a computer. 
 
 Using a sound editing application. 
 
 Saving and retrieving computer files. 
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Activity 3.0 : Using a Scanner 

 
Purpose: 

 
To use a scanner to create a digital image. 

 
Resources required: • Samples of black and white drawings, colour drawings and 

photographs. 
• Scanner and software 
• Attachment (3.0) “Using a scanner” 
• Attachment (3.1) “Respecting copyright” 
• Attachment (3.2) “Image file format – which one to use?” 

 
Teaching Procedures: Activity based investigation using  Attachment (3.0) 

 
Time allocation: 10 minutes 

 
What to do FACILITATOR PARTICIPANT 

3.1 Organise participants into 
groups and have floppy disks 
or hard disk space allocated 
for each group. 

 
3.2 Refer to Attachment (3.0) 

"Using a scanner".  Copy and 
use handout as required. 

 
 
 
 
 
 
 
 
 
 
3.3 Handout Attachments (3.1) 

“Respecting copyright”and 
Attachment (3.2) “Image file 
format – which one to use?”.  
Suggest participants read 
these when time permits. 

 
3.4 Using the board, continue 

with the definition or question 
and answer diary. 

 

3.1 Form into working groups and 
with equipment as required. 

 
 
3.2 Read Attachment (3.0) and 

digitalise at least one colour 
photograph and a line 
drawing. 

 
Save files onto a floppy disk 
or the computer's hard disk 
and view the file by double 
clicking on the filename from 
within the computer's file 
manager (e.g. Windows 
Explorer) 

 
3.3 Explore, as time permits, the 

various editing options in the 
scanning software, such as 
resize, crop, and recolour.  

 
3.4 Add unfamiliar terms or 

questions and answers 
obtained during this activity to 
the definition or question and 
answer diary. 
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 Discuss/Consider: 
• The effects of file format and image dimensions on file size. 
 
•  Attachment (3.1) “Respecting copyright” 
 
• Attachment (3.2) “Image file format – which one to use?” 

 
 

Tips and Tricks: • When scanning several images, you can save time by placing the 
images on exactly the same place on the scanner each time. 

 
• To obtain the same size image for numerous scans, set the image 

size required, then scan the images. 
 
• Similar to photocopying a photocopy, rescanning a scanned image 

will result in a loss of image quality.  If the image is to be edited a 
number of times, it is best to scan it first at high quality and close 
to the original dimensions as file size will permit, otherwise scan it 
using the final format and dimensions required. 

 
• Use some of these scanned images for use in later activities. 
 
• Files may have their format converted so they can be imported into 

other applications.  See Attachment (3.2). 
 
 

Skills Checklist:  Operating an image scanner. 
 
 Scanning photographs and drawings. 
 
 Saving and retrieving computer files. 
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Activity   4.0 :  Image Enhancement and Special Effects 

 
Purpose: 

 
 To enhance and manipulate digital images to create multiple 'versions' 
of the one image, and use digital still images to create a digital video. 

 
Resources required: • Sample of manipulated images can be found on the CD at: 

      Lrntech/activity-4/demo*.bmp and  
      Lrntech/activity-4/demo*.avi 
• Attachment 4.2 explains the techniques used in manipulating the 

images.   
• A collection of suitable images for manipulation.  Several still 

images from the CD could be used for this activity.  These can be 
found at: 

   Lrntech/activity-4/image*.bmp 
• A painting program such as MS Paint (limited features), MS 

PhotoEditor (comes with the MS Office suite) or PaintShop Pro 
(The shareware version of the program can be found on the CD at: 
Software/PaintShopPro/) or other image enhancement 
software such as those that accompany a digital camera. 

• An animation or morphing program such as PhotoMorph (The 
shareware version of this can be found on the CD at: 

      software/PhotoMorph/). 
• Attachment (4.0) "Manipulating digital images". 
• Attachment (4.1) "Digital stills to digital video". 
• Attachment (4.2) “Image Enhancement and Special Effects”  

 
Teaching Procedures:  Activity based investigation using Attachments  (4.0) and (4.1)   

 
Time allocation:  15 minutes 

 
What to do FACILITATOR PARTICIPANT 

 4.1 Display a number of prepared 
images (.bmp files) which have 
been manipulated (Change 
contrast, hue, embossed, 
negative etc.) or merged or 
morphed (video created from 
separate images, .avi files).  
Discuss briefly the techniques 
by which they were created 
(Attachment 4.2). 

 
4.2 Divide participants into groups 

of two.  Have each pair select 
several .bmp files from the CD 
for manipulation or morphing 
using the shareware software 
provided. 

4.1 View and discuss the 
prepared images presented. 

 
 
 
 
 
 
 
 
 
4.2 Divide into pairs and 

practice manipulating the 
prepared files. Discuss 
difficulties encountered. 
Save the manipulated file 
with a new file name. 
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4.3 Using the board, continue with 

the definition or question and 
answer diary. 

 
 

4.3 Add unfamiliar terms or 
questions and answers 
obtained during this activity 
to the definition or question 
and answer diary. 

 
 Discuss/Consider: 

• Discuss briefly the strengths and weaknesses of manipulating 
digital images as a learning tool and record suggestions on the 
whiteboard. 

 
• The manipulation of the images as a resource for creating 

classroom teaching materials, ie worksheets, displays, 
presentations. 

 
• The development and recording of material for a student’s 

portfolio. 
 
• The use of special effects on images to enhance features of interest 

or improve visual interest. 
 
• The value of creating digital video from digital still images for use 

in the science classroom. 
 

Tips and Tricks: • Store all the images for a piece of work or module in the same 
directory. 

 
• Decide on the final image dimensions before multiple images are 

made. 
 
• When selecting digital images to be merged into digital video the 

still images should be the same size and colour depth. 
 
• Participants may find it an advantage to pair with a person of 

similar background or subject areas, ie Primary or Secondary, 
chemistry, biology or physics. 

 
• Encourage participants to focus on developing specific applications 

of the techniques demonstrated for their classroom practice. 
 
For Web sites with lots of images see: 
http://www.dewa.com/3D/http://ftp1.rad.kumc.edu/clips/index.htm 

 
Skills Checklist:  Using different image filters on a digital image to gain multiple 

effects. 
 Saving and retrieving computer files. 

 

http://www.dewa.com/3D/
http://www.dewa.com/3D/
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Activity 5.0 : Using a Digital Camera to Capture Still Images 

 
Purpose: 

 
To create a digital image using a digital camera. 

 
Resources required: • Digital camera attached to a computer, such as “QuickCam VC”or 

“CUCUS” or a standalone digital camera such as Kodak “DC50” 
or the Sony “Mavica”. 

• Software drivers for camera. 
• Attachment (5.0) "Capturing still images with a digital camera". 

 
Teaching Procedures: Activity based investigation using Attachment (5.0). 

 
Time allocation: 20 minutes 

 
What to do FACILITATOR PARTICIPANT 

5.1  Organise participants into 
groups and have floppy disks 
or hard disk space allocated 
for each group. 

 
5.2 Refer to Attachment (5.0) 

"Capturing still images with a 
digital camera".   Copy and 
use handout as required. 

 
5.3 Refer to Attachment (5.1) 

"Setting up a QuickCam VC". 
 

5.1 Form into working groups 
with equipment as required. 

 
 
5.2 Read Attachment (5.0) and 

capture an image using the 
camera.   

 
 
5.3 Explore features of the camera 

available, such as how it is 
attached to the computer, 
focus adjustment and the 
format of image files 
produced. 

 5.4 Refer to Attachment (5.2) 
"Setting up a Kodak DC50". 

 
 
 
 
 
 
 
 
 
5.5 Using a board, continue with 

the definition or question and 
answer diary. 

 

5.4 Explore features of software 
such as brightness, contrast, 
hue controls. 

 
Use the camera to take a few 
still shots. Save the files onto a 
floppy disk or hard disk. 
 
View the images and save 
them onto a floppy disk. 

 
5.5 Add unfamiliar terms or 

questions and answers 
obtained during this activity to 
the definition or question and 
answer diary. 
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 Discuss/Consider: 
• How digital images could be used in the classroom and integrated 

into special class projects to aid record keeping and data collection. 
 
• The transportability and ease of use of a stand-alone camera 

compared with a camera and attached laptop computer. 
 
• Using shareware software (PhotoMorph) to animate a sequence of 

images to create a 'time-lapse' video. 
 
• The improved image resolution of the standalone digital cameras 

(Kodak or Sony) compared with the less expensive “CUSUS” or 
“QuickCam VC”. See Attachment (3.2). 

 
 

Tips and Tricks: •  Set up and test equipment before participants are assembled. 
 
• After each participant has captured their image with the camera, 

while the next participant is using the camera, they could practice 
enhancing the image (Activity 4.0) using MS PhotoEditor or 
PaintShopPro.  

 
 

Skills Checklist:  Using a digital camera to take still images.  
 
 Transferring of images onto the computer 
 
 Saving, retrieving and viewing image files. 

 
 

Web sites: • Sony “Mavica” digital imaging camera 
http://www.sel.sony.com/SEL/consumer/ss5/pin.shtml 
 
• Connectix QuickCam Cameras 
http://www.logitech.com/au/cameras/index.html 
 
• Kodak Digital Cameras 
http://www.kodak.com/US/en/digital/cameras/DCSGateway.jhtml 
 
• Kodak Digital Learning Centre 
http://www.kodak.com/US/en/digital/dlc/ 
 

 

http://www.sel.sony.com/SEL/consumer/ss5/pin.shtml
http://www.logitech.com/au/cameras/index.html
http://www.kodak.com/US/en/digital/cameras/DCSGateway.jhtml
http://www.kodak.com/US/en/digital/dlc/
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Activity 6.0 : Using a Digital Video Camera 

 
Purpose: 

 
To use a digital video camera to create a digital video. 

 
Resources required: • Digital video camera such as a “QuickCam VC”, “CUCUS” or 

Sony “Mavica”. 
• Floppy disks if using a Mavica. 
• Attachment (6.0) "Using a digital video camera". 

 
Teaching Procedures: Activity based investigation using Attachment (6.0). 

 
Time allocation: 20 minutes 

 
What to do FACILITATOR PARTICIPANT 

6.1 Organise participants into 
groups and have floppy disks 
or hard disk space allocated 
for each group. 

 
6.2 Refer to Attachment (6.0) 

"Using a digital video 
camera".  Copy and use 
handout as required. 

 
6.3 Refer to Attachment (5.1) 

"Setting up a QuickCam VC " 
 
 
 
 
 
 
 
 
 
 
 
 
6.4 Using a board, continue with 

the definition or question and 
answer diary. 

 
 

6.1 Form into working groups 
with equipment as required. 

 
 
6.2 Read Attachment (6.0) and 

attempt to create a short video 
(3-4 second) using the 
equipment provided. 

 
6.3 Explore features of the camera 

such as how it is attached to 
the computer, file sizes and the 
file formats used. 
 
Explore features of software 
such as audio quality, frame 
rates and available colour 
choice. 
 
After taking a short (3-4 
second) video, save the file 
onto a floppy disk or the hard 
disk and replay. 

 
6.4 Add unfamiliar terms or 

questions and answers 
obtained during this activity to 
the definition or question and 
answer diary. 
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 Discuss/Consider: 
• File format, size, and storage. 
 
• Uses of digital video in the classroom to assist in instruction and 

demonstration. 
 
• Transportability of a camera and laptop. 
 
• The ease of use of time lapse video and animation using single 

frame options. 
 
 

Tips and Tricks: • Refer to examples of time lapse video and single frame animation 
provided on the CD under: 

   Lrntech/activity-6/video*.avi 
 
• Insist that the sample video is short or the required file sizes will be 

too large for saving onto a floppy disk.  
 
 

Skills Checklist:  Using a digital camera to take a video.  
 
 Transferring of images onto the computer. 
 
 Saving, retrieving and viewing video files. 

 
 

Web sites: • Sony “Mavica” digital imaging camera 
http://www.sel.sony.com/SEL/consumer/ss5/pin.shtml 
 
• Connectix QuickCam Cameras 
http://www.logitech.com/au/cameras/index.html 
 
• Kodak Digital Cameras 
http://www.kodak.com/US/en/digital/cameras/DCSGateway.jhtml 
 
• Kodak Digital Learning Centre 
http://www.kodak.com/US/en/digital/dlc/ 
 

 

http://www.sel.sony.com/SEL/consumer/ss5/pin.shtml
http://www.logitech.com/au/cameras/index.html
http://www.kodak.com/US/en/digital/cameras/DCSGateway.jhtml
http://www.kodak.com/US/en/digital/dlc/
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Activity  7.0  : How to Use Digital Elements in the Science Classroom 

 
Purpose: 

 
To devise and record a variety of ways that digital elements could be 
used to enhance learning in the science classroom.  

 
Resources required: A2 sheets of paper, pens, video-clips from CD:    

Lrntech/activity-7/Daphnia.avi 
Lrntech/activity-7/Saturn.avi 
Lrntech/activity-7/POE steelwool SF3.avi 
Lrntech/activity-7/images*.bmp   
Attachment (7.0) “Ideas for digital elements in Science” 

 
Teaching Procedures:  Brainstorming, and group discussion. 

 
Time allocation:  20 minutes 

 
What to do FACILITATOR PARTICIPANT 

 7.1 Demonstrate a number of the 
prepared images and video-
clips to the participants and 
discuss briefly the technique 
by which they were created. 
(See Attachment 7.0)  

 
7.2 Divide participants into 

groups of four.  Pass out 
sheets of paper and pens to 
each group.  Have each group 
discuss and record ways in 
which they could use, or have 
used digital elements in their 
science classes. 

 
7.3 Have each group report back 

suggestions to the whole 
group and discuss proposals 
and discuss briefly the 
strengths and weaknesses of a 
digital media as a learning 
tool.  Record suggestions on 
the whiteboard.  These can be 
recorded and duplicated for 
distribution or posted on the 
online discussion area. 

 
7.4 Using a board, continue with 

the definition or question and 
answer diary. 

7.1 View the prepared images and 
video-clips presented. 

 
 
 
 
   
  
 
7.2 Divide into groups and 

discuss and record suggested 
uses of digital elements in the 
science classroom. 

 
 
 
 
 
7.3 Report back to the whole 

group and discuss/comment 
on suggested proposals.  

 
 
 
 
7.4 Add unfamiliar terms or 

questions and answers 
obtained during this activity 
to the definition or question 
and answer diary. 
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 Discuss/Consider: 
Using a digital camera to capture images for: 
• Creating classroom teaching materials. eg worksheets The 

development and recording of material for a student’s portfolio. 
 
• Recording experimental results for future analysis by the class or 

for presentation by groups of students. 
 
• Recording of microscopic life as still images or video. 
 
• Recording of time based observations, ie plant or mould growth 

using time lapse options. 
 
• Optical experiments ie refraction, dispersion, infrared observation.  

Recording images as the eye would see them. 
 
• The observation of remote or hazardous events usually performed 

in the safety of a fume cupboard or outdoors. 
 
• Analysis of events over short time intervals using single frame 

advance of captured video. 
 
• The demonstration of critical or expensive procedures or events, ie 

animal dissections or use of liquid nitrogen. 
 
Advantages/disadvantages of the technology 
• The ease, with which multimedia material can be stored, reused 

and shared between teachers using e-mail or web pages. 
• The cost of equipment (A data projector is an expensive item at 

≈$6000 and replacement bulbs may be up to $300 each). 
• The manufacture’s frequent upgrading of software and equipment 

and the poor connectivity due to multiple industry standards. 
• The low user costs after initial equipment purchase. 
• Cost of equipment repairs and servicing. 

 
 

Tips and Tricks: • During the presentation of the prepared images and video it is 
important to note that all have been prepared using equipment 
available to most primary schools and colleges.  They have been 
included to demonstrate possible applications.     

 
• In small group activities it may be beneficial to have members with 

a mix of school and subject backgrounds ie Primary, Secondary, 
chemistry, biology and physics. 

 
• Try to get groups to focus on specific applications of the 

technology in their classroom.   
 



Science Extended PD  Learning Technologies in School Science 
MODULE CONTENT 

 

Faculty of Education, Monash University and the Department of Education Employment and Training 
Page 17 

 
Activity   8.0  :  Integrating Audio and Images into a Science Presentation 

 
Purpose: 

 
 To introduce participants to the ease of creating a multimedia 
presentation. 

 
Resources required: • Sample MS PowerPoint presentation which incorporates a variety 

of images and video clips as a discussion starter.  On CD at 
Lrntech/activity-8/Presentation.ppt 

• Samples of audio, images, video and text from the CD at 
Lrntech/activity-8/ 

• MS PowerPoint version 97, though earlier versions will cover some 
of the sections of the activity presented. 

• Attachment (8.0) “Creating a multimedia resource using 
PowerPoint 97”. 

 
Teaching Procedures:  Activity using Attachment (8.0) “Creating a multimedia resource 

using PowerPoint 97”. 
 

Time allocation:  25 minutes 
 

What to do FACILITATOR PARTICIPANT 
 8.1 Organise participants into 

groups (The size will depend 
on the availability of 
computers). 

 
8.2 Outline the task – To insert an 

image, a sound, a video and 
text into a presentation of no 
more than three slides.) 

 
 
 
 
 
 
 
 
8.3 Discuss briefly with all 

participants the strengths and 
weaknesses of multimedia 
presentations created by the 
teacher or learner as a learning 
tool and record suggestions on 
the whiteboard. 

 
8.4 Using a board, continue with 

the definition or question and 
answer diary. 

8.1 Form into working groups. 
 
 
 
 
8.2 Read Attachment (8.0) and 

attempt to complete the task. 
Participants may wish to use 
the following files from the 
CD (Lrntech/activity-
8/) in conjunction with 
Attachment (8.0) for this 
module: 

Clap.wav (audio file) 
Butterfly.avi (video file) 
Butterfly.bmp (image file) 
 
8.3 Discuss briefly the strengths 

and weaknesses of 
multimedia presentations.  
Record suggestions. 

 
8.4 Add unfamiliar terms or 

questions and answers 
obtained during this activity 
to the definition or question 
and answer diary. 
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 Discuss/Consider: 

• The “non-linear” pathway a student may choose to take through the 
presentation in comparison with the pathway that the creator may 
have intended.  “Is all the content intended in the presentation still 
being covered?”  

 
• What is being learned?  The intended content or the presentation 

technology? 
 
• How group dynamics of the class may influence the intended 

learning outcomes using multimedia technology. 
 

Tips and Tricks: • The above tasks are intended to prepare participants for the final 
activity.  It is important that participants demonstrate sufficient 
understanding of this activity before attempting the final activity. 

 
• Save all files associated with a presentation in a separate directory. 
 
• As a general rule, use a dark background with light text for a 

presentation to be displayed on a screen, and use a light 
background and dark text for a presentation to be printed. 

 
• MS PowerPoint presentations can be easily reformatted for 

distribution over the Web.  To do this File>Save As HTML option. 
 
• Participants should be encouraged to experiment with the variety of 

options available in this versatile program. 
 
• Participants should be made aware that there are training Web sites 

eg; 
http://www.microsoft.com/education/curric/ppt97/start.htm 
http://www.kodak.com/US/en/digital/dlc/ 
 
• A Web location for free sound clips: 
http://www.soundcentral.com/computer/cartoon/ 
• Web locations for free video clips: 
http://www.yahoo.com/Entertainment/Movies_and_Films/Multimedia/
Video_Clips/  
and  http://www.JurassicPunk.com/movies.html 
 

 
Skills Checklist:  Inserting text into PowerPoint. 

 Inserting graphics into PowerPoint. 
 Inserting video into PowerPoint. 
 Inserting sound into PowerPoint. 
 Running a PowerPoint presentation. 

 

http://www.microsoft.com/education/curric/ppt97/start.htm
http://www.kodak.com/US/en/digital/dlc/
http://www.soundcentral.com/computer/cartoon/
http://www.yahoo.com/Entertainment/Movies_and_Films/Multimedia/Video_Clips/
http://www.yahoo.com/Entertainment/Movies_and_Films/Multimedia/Video_Clips/
http://www.tcfhe.com/capsule/assets/abyss1.mov
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Activity 9.0 : Creating a Simple Science Multimedia Resource 

 
Purpose: 

 
• To encourage participants to co-operatively plan and commence 

construction of a science based multimedia resource using the 
skills and ideas acquired from previous activities.  

  
 

Resources required: • Software, such as MS Word 97 or MS PowerPoint. 
• Digitised multimedia elements such as audio, still images and 

video which can be created or downloaded from the Web. 
• Attachments as required. 
• Computer peripherals as required. 

 
Teaching Procedures: Introduction to an activity based task. 

 
Time allocation: 20 minutes  

 
What to do FACILITATOR PARTICIPANT 

9.1 Set participants the task of 
planning the development of a 
multimedia resource which 
could be used in a science 
lesson. They should attempt to 
use a variety of digital 
elements and incorporate 
images, audio and video into a 
MS Word 97 document or MS 
PowerPoint presentation. 

 
9.2 Participants should be 

encouraged to work in a group 
of three members to work to 
plan the resource.  Refer to 
ideas which were raised in 
Activity 7. 

 
9.3 Participants should be 

encouraged to complete the 
multimedia resource after the 
PD session is finished.  The 
resource could be developed 
by individual participants, 
between participants, or with 
students. 

 

9.1 Discuss purpose of task, and 
suggest some ideas for the 
resource and how it could be 
evolved in 'classroom' 
situation. 

 
  
 
 
 
 
 
 
 
9.2 Form groups of three and 

select a topic or component of 
science they wish to 
development a multimedia 
resource for 

9.3 Develop a strategy to develop 
this resource away from the 
PD program. 
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 Discuss/Consider: 
• How the development of the resources could be part of classroom 

practice. 
 
• Collaboration between schools (students and teachers) to develop a 

multimeida resource. 
 
• Arrangements for participants to share the completed multimedia 

presentations - this could be through the on-line discussion area of 
the DEET..(http://www.sofweb.vic.edu.au  > Discussion Groups) 

 
Tips and Tricks: • The aim of the task is to encourage the participants to plan the 

production of a simple science multimedia resource which could be 
used in their classroom.  The multimedia resource could be 
planned, created or appropriate images and sounds could be 
researched and downloaded from the Internet.  

 
• The task provides a valuable opportunity for participants to work in 

small groups, reflect on the contributions of others, exchange ideas, 
build skill and confidence in exploring the application of the 
learning technology demonstrated. 

 

http://www.sofweb.vic.edu.au/
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Module Review  
 

Between Session 
Tasks: 

Participants should be encouraged to work on Activity 9.0 and to share 
materials developed with the rest of the participants. 

 
Support Materials: Attachments as below can be found on the CD under 

LrnTech/Attachments/; 
1.0 Digitising audio from a cassette tape 
2.0 Creating digital audio 
3.0 Using a scanner 
3.1 Respecting Copyright  
3.2 Image file formats –Which one to use? 
4.0 Manipulating digital images 
4.1 Digital stills to digital video 
4.2 Image Enhancements and special effects 
5.0 Capturing still images with a digital camera 
5.1 Setting up a Logitech/Connectix “QuickCam – VC” 
5.2 Setting up a Kodak DC50 
6.0 Using a digital video camera 
7.0 Ideas for digital elements in Science 
8.0 Creating a multimedia resource using MS PowerPoint 97 

Note – no attachments for activity 9 
 
Product information is available from the following sites: 
 

 Sony “Mavica” digital imaging camera 
http://www.sel.sony.com/SEL/consumer/ss5/pin.shtml 
 

 Connectix QuickCam Cameras 
http://www.logitech.com/au/cameras/index.html 
 

 Kodak Digital Cameras 
http://www.kodak.com/US/en/digital/cameras/DCSGateway.jhtml 
 

 Kodak Digital Learning Centre 
http://www.kodak.com/US/en/digital/dlc/ 

 

http://www.sel.sony.com/SEL/consumer/ss5/pin.shtml
http://www.logitech.com/au/cameras/index.html
http://www.kodak.com/US/en/digital/cameras/DCSGateway.jhtml
http://www.kodak.com/US/en/digital/dlc/
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